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This manual provides step-by-step instructions for performing cell count based 
normalization of Seahorse XF data using Agilent's Seahorse XF Imaging and Cell 
Counting Software. This software automates the process of performing brightfield and 
fluorescence image acquisition as well as the calculation of cell counts in Seahorse XF 
microplates. 

The Seahorse XF Imaging and Cell Counting Software is a required component of the 
XF Imaging and Normalization System. 

This document also describes how to use data analysis features in Wave software (Wave 
Desktop and Wave Controller, Wave Pro) so that researchers can perform more 
successful cellular metabolism assays.
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1 Introduction

Requirements

Required Hardware
• XFe Controller (Windows 10, 64-bit) and XFe96 Analyzer or XFe24 Analyzer
• XF Pro Controller (Windows 10, 64-bit) and XF Pro Analyzer
• Handheld Barcode Wand
• BioTek Instrument's Cytation 1 Cell Imaging Multimode Reader

OR
BioTek Instrument's Cytation 5 Cell Imaging Multimode Reader

Required Software
• For XFe Analyzers: Wave Controller and Wave Desktop software, version 2.6 or later
• For XF Pro Analyzers: XF Pro Controller Software Version 10.0.1 (or later) and 

Wave Pro 10.0.1 (or later) 
• Seahorse XF Imaging and Cell Counting Software Version 1.1.0.17 
• Gen5 Image+ (GEN5IPLUS) software minimum

https://www.agilent.com/en/products/cell-analysis-(seahorse)/software-download-for-wave-desktop
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Support

Agilent Cell Analysis (Seahorse) Support
Email: cellanalysis.support@agilent.com

USA and Canada 

Global/United States: 

+1 719 528 7500 

United States (Toll Free): 

+1 800 227 9770; select option 3 then 8 

Europe 

European (Toll Free): 

00 800 345 347 00 

(UK, Ireland, France, Germany, Denmark, or Netherlands) 

Other Countries: 

+45 8830 5500 

China (Toll Free Landline): 

800 820 3278 

China (Toll Free Mobile Phone): 

400 820 3278

BioTek Instruments, Inc. Support
Email: TAC@biotek.com

Phone: (800)242-4685
(800)655-4740

Or see BioTek's support page, here.

https://www.biotek.com/contact/?gclid=CjwKCAjw4sLVBRAlEiwASblR-9BmpU2Wx7YvH1TkInkjVbFXl-KTG8hAyGMBpo7F0hcKojn__fZdcBoCWlMQAvD_BwE
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Save result files with images 15

This section gives an overview of new image integration and normalization features in 
Wave.
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2 New Features in Wave

Well View/Import Images

Agilent Seahorse Wave Controller, Wave Desktop, and Wave Pro supports the addition 
and association of well images through the Cell Imaging application. Upon completion 
of XF Assay, import and view collected images by adding the Well View from the Add 
View tab. In this tab, all image sets are visible on the left (Set refers to a single read of a 
cell plate. One plate's file can accommodate multiple sets of images). After selecting an 
image set, any images collected in the Cell Imaging application may be imported to a 
plate's Wave assay file. Select the entire plate or specific wells before clicking Import 
Selected.

Flagging

Upon review of images in Wave, individual wells can be flagged for further review. 
When one well is in view, simply click the star in the upper right-hand corner of the 
image. The flag will be applied to the well throughout the different review screens in 
Wave. Note that this will not remove or adjust the data for this well. Additionally, in the 
Well View tab, flags created in the Cell Imaging application environment can be 
imported by clicking Import Flags.

NOTE Importing images may take several minutes. Images that have been imported are in a 
compressed format. Full resolution images can be exported from the Cell Imaging 
application.
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Heat Maps

Heat Maps allow a quick graphical view of cell count data. Color saturation of the well is 
indicative of the value of the cell count. A higher cell count will result in a darker 
shading of the well. Heat Maps may be viewed by group or across the entire plate. You 
can quickly identify if a few wells are significantly different from the rest of the group. 
The options are shown in the Well View tab. An example is shown below with the Heat 
Map selection menu highlighted.

Figure 1 Well view tab with Heat Map menu seen in Wave Controller software
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2 New Features in Wave

Compare Wells

To compare the images of two or more wells, simply select the wells you wish to view, 
and then click Compare Wells. This will open an image viewer with all selected images. 

Use the options on the left-hand bar of the viewer to toggle to a more detailed view. 
Click on one well to view it with more details. 

NOTE Wells can only be compared within the same image set. 

Figure 2 Compare Wells view
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Compare Sets

To see all images of a single well that have been collected, select the well you wish to 
view, and then click Compare Sets. This will open an image viewer with all the 
collected images of that specific well. 

Figure 3 Compare Sets view
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2 New Features in Wave

Import Cell Counts

Once fluorescent images and cell counts have been collected, the counts are available for 
normalization. 
1 Navigate to the Normalization tab. There will be an icon to alert if cell counts are 

available for the plate. 
2 Click Import and the normalization table will fill with cell counts. 

Notice that any wells defined as background correction wells in the assay plate map 
do not show a cell count - the default count for any background wells is 0. The scale 
factor imports as a factor of 1,000 Cells.

Figure 4 Normalization tab with cell counts imported
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Save result files with images

After importing images into Wave from the Cell Imaging application, notice that Wave 
will keep track of the images and file size in the Well View tab. The file must be saved 
after image import in order to export the data file with images. Note that upon importing 
the images to Wave, they are compressed from their original versions.

Figure 5 Well view tab with imported images
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2 New Features in Wave
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This section reviews some useful features in the Cell Imaging application.
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3 Seahorse XF Imaging and Cell Counting Software

Software Introduction

Getting started
The Agilent Seahorse Integrated Imaging and Metabolic Analysis Solution requires the 
parallel use of both Agilent Seahorse XFe or XF Pro Analyzer and BioTek Cytation 1 or 
Cytation 5 instruments. This section assumes that the appropriate field specialists have 
installed the instruments and familiarized the users with their operation. Both 
instruments are operated using the same 64-bit, Windows 10 OS controller. This section 
outlines recommendations for powering on the systems and setting up save locations for 
files. 

Powering the system

The following is a recommendation of the order in which each instrument should be 
powered on. Assuming all instruments and controller are powered off:
1 Ensure all components are connected: power cords, 1 USB for XFe or XF Pro, 2 USB 

for Cytation instrument, 1 serial cable for XFe or XF Pro, and 1 USB for external 
barcode wand. Additionally, if using a hardwired LAN connection, connect an 
ethernet cable.

2 Power on the controller, and log into the Windows system. 
3 Power on the XFe or XF Pro Analyzer.

a After switching the analyzer on, wait a few moments before opening Wave. 
b While the software is initializing, listen for the motor to move, and check for 

connectivity status in the status bar. This may take a few minutes. 
c If there are problems with connectivity, contact Agilent Support. 

4 Power on the Cytation 1 multimode plate reader. 
a Open XF Imaging and Cell Counting. The camera will initialize, the instrument 

may chirp and open the tray. 
b To close the tray, press the button next to the door. 
c Watch for connectivity in the status bar of the XF Imaging and Cell Counting 

software. 
d If there are problems with connectivity, close XF Imaging and Cell Counting and 

try connecting the instrument with Gen5. For further problems, contact BioTek 
Support. 

NOTE The XFe and XF Pro Analyzers require time to reach operating temperature and 
equilibrate. It is recommended that the instrument be turned on the day before an assay is 
planned to allow for adequate equilibration. 
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Image storage location

Image Library (This contains all raw images collected by the Cytation)

Because of the number of large image files that are created using this system, both 
Agilent and BioTek require that users move the image library off the controller’s hard 
drive and either onto a multi-terabyte external hard drive, or to a network location. If the 
hard drive runs out of space, it will affect software performance. The Image Library 
must be set up through Gen5. To change the image library file path, go to: System > 
Preferences > Image Save Options in Gen5. 

See Figure 6 for help navigating this menu. For further assistance, contact BioTek. 

Figure 6 Image Save Options
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3 Seahorse XF Imaging and Cell Counting Software

XF Imaging and Cell Counting Image Database

Upon installation of XF Imaging and Cell Counting Software and Wave, an image 
database will be created. This database allows Wave to identify the correct image files 
for plates that have been imaged, and import those images and cell counts into the assay 
file. The default location for the database is on the computer's hard drive. If assay review 
and image import are completed away from the controller for example, on a PC with 
Wave Desktop or Wave Pro installed, the database must be moved to either a network 
location or a portable hard drive. Use the help menu in XF Imaging and Cell Counting 
and the Options menu in Wave to change the image database location, then restart both 
software programs. If a new file path is chosen, a new database will be created once the 
images are collected using XF Imaging and Cell Counting software. Figure 7 shows a 
screenshot of the Wave Options menu.

Image library and database location setup examples

the following examples to help set up the image library and database locations: 

Removable USB Storage Device Configuration:

Wave -> Options -> Database: 
C:\Users\Admin\AppData\Local\Vortex\Database

Imaging and Cell Counting -> Help -> Database: 
C:\Users\Admin\AppData\Local\Vortex\Database

Gen5 (Image Library)-> Settings -> Image Save Options: 
D:\Gen5 Images

Figure 7 Wave Options Menu

NOTE If the database is changed after images were collected, import the images to .asyr files 
prior to moving the database. Alternatively, find the existing database and move it to the 
new file path.
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Networked Devices

If you are networking your Controller so that you can import cell counts and images 
remotely, the Imaging and Cell Counting database and Gen5 image library must be in a 
shared directory. For example, set up two shared directory locations:

\\shared server\shared directory\Vortex\Database

\\shared server\shared directory\Images 

The settings in the software applications must reflect these directories:

Wave -> Options -> Database: 

\\shared server\shared directory\Vortex\Database

Imaging and Cell Counting -> Help -> Database: 

\\shared server\shared directory\Vortex\Database

Gen5 (Image Library)-> Settings -> Image Save Options: 

\\shared server\shared directory\Images

Home screen

Figure 8 on page 21 shows the main menu of the XF Imaging and Cell Counting 
Software. In this view, there are three sections of the screen that are interactive (each 
highlighted in yellow boxes). 

Status bar

The bottom left section of the screen reveals the status of the instrument and software. 
This bar is available through all data collection and review screens as well. It is 
displayed from top to bottom as follows:

Figure 8 XF Imaging and Cell Counting Home Screen
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3 Seahorse XF Imaging and Cell Counting Software

Current temperature

The internal incubation temperature of the Cytation instrument is shown.

Temperature control

The instrument heater status is shown (On or Off). To open options for turning the 
heater on/off, and setting the temperature, click the icon or text. 

Connection status

The connection status continually checks connections to both the handheld Barcode 
Wand and BioTek’s Gen5 software. If either of these is disconnected, the icon turns 
red, and the software will be “Not Ready.” 

Cytation tray control

To manually open and close the Cytation tray, click the Cytation tray icon. 

Help menu

Open the help menu for support and software information. For more details, see 
“Help menu" on page 23.

Scan plate to start

This section shows how to scan the plate barcode and place the plate on the tray holder to 
begin imaging protocols. This section is not interactive from the controller, a barcode 
must be scanned.

View/Manage pictures

This menu displays the four most recent image sets. To review previously imaged cell 
plates, click one of the sets shown or the View All button. 

NOTE Note that the imaging protocols require the Cytation 1 temperature to be 37 °C during 
image collection. 
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Help menu

The following paragraphs define the sections of the help menu.

Support

Use this section to find the phone number and email address to contact a member of our 
support team to assist you. Additionally, use the link to the Agilent Support website to 
find some technical resources. 

Save system files

If the Technical Support team requests system files, use this button to find and send the 
appropriate files. The Test Barcode Wand button reveals an image of a barcode - use 
this to test the handheld barcode wand. Simply use the barcode wand to read the barcode 
displayed on the Controller's screen. 

Software information

Details in this section display software and license information. This is where the MAC 
address, which is needed during XF Imaging and Cell Counting Software licensing, is 
found. 

Image database

This section of the help menu displays the file path for the image database. This database 
must be the same in Wave (this can be found in Wave’s Options menu). If the database 
location is changed, both XF Imaging and Cell Counting and Wave software should be 
restarted. 

Figure 9 Help menu seen in Wave Desktop and Wave Controller software
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3 Seahorse XF Imaging and Cell Counting Software

Features

Flagging
Upon review of both brightfield and fluorescently stained images, individual wells can 
be flagged for further review. For example, a brightfield image reveals one well is not as 
confluent as another; the well may be flagged in Cell Imaging by clicking the upper 
right-hand corner of the image during review, and the flags can then be imported into 
Wave.

Masked Images
Upon completion of fluorescent image scans, images may be reviewed for cell counting 
accuracy in Cell Imaging software. In this view, the option to View Counted Cells is 
available by clicking the checkbox in the lower right-hand section of the screen. (This 
feature is only available immediately after fluorescent images are collected; these are not 
saved, so they cannot be reviewed later). The overlay highlights the counted objects in 
the images to show efficacy of the counting algorithm. 

Figure 10 Viewing counted cells
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Workflow

The procedure outlined in this guide assumes working knowledge of the XFe Analyzer 
and XF Assay Kits. This procedure can be adopted for use with any XF Assay Kit. For 
instructions on XFe Analyzers, Wave, and XF Assay kits, refer to each item's user 
manual. For more information on basic procedures needed to run an XF Assay, see the 
"Procedures to Run an XF Assay" on the Agilent Technologies, Inc. website, here.

The flowcharts in Figure 11, Figure 12, and Figure 13 display the XF Assay workflow 
with the Imaging and Cell Counting Application for Normalization.

Figure 11 Imaging and cell counting workflow (1 of 3)

https://www.agilent.com/en-us/products/cell-analysis-(seahorse)/basic-procedures-to-run-an-xf-assay?sh_0009
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Figure 12 Imaging and cell counting workflow (2 of 3)
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Figure 13 Imaging and cell counting workflow (3 of 3)
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3 Seahorse XF Imaging and Cell Counting Software

Important Notes

• XF software application updates may occasionally become available. Upon opening 
or restarting Wave or Imaging and Cell Counting applications, you may be prompted 
to update the software. For the most accurate and up-to-date features, update the 
applications when prompted.

• Images and the image directory should not be stored on the XFe Controller as it can 
cause instability in Wave and Cell Imaging if the disk becomes full. BioTek and 
Agilent recommend using a network location or external hard drive for image 
storage. (Directions for networking can be found here.)

• Gen5 software for the Cytation 1 must be licensed from BioTek Instruments, Inc. For 
help with the Cytation, Gen5 software and licensing, refer to BioTek.

• This is the recommended order of operations for running an XF Assay with Cell 
Imaging software. Downtime has been minimized or noted where applicable. 

Day(s) Prior to Assay
1 Turn on the XFe or XF Pro Analyzer to allow it to warm up and equilibrate overnight.
2 Plate cells in Seahorse XF Cell Culture Microplates using cell culture growth 

medium. 
3 Hydrate sensor cartridge in Seahorse XF Calibrant at 37 °C in a non-CO2 incubator 

overnight. 
4 Design experiment in Wave. See the instrument user manual for additional details. 

Day of the Assay

Preparing and Running an XF Assay

Refer to the online guides in the links below for assistance in running XF Assays and for 
more information on Seahorse XFe Consumables and Kits:
• Procedures to Run an XF Assay
• Seahorse XFe or XF Pro Consumables

https://www.biotek.com/contact/?gclid=CjwKCAjw4sLVBRAlEiwASblR-9BmpU2Wx7YvH1TkInkjVbFXl-KTG8hAyGMBpo7F0hcKojn__fZdcBoCWlMQAvD_BwE
https://www.agilent.com/en-us/products/cell-analysis-(seahorse)/basic-procedures-to-run-an-xf-assay?sh_0009
https://www.agilent.com/en/product/cell-analysis/real-time-cell-metabolic-analysis/xf-sensor-cartridges-cell-culture-microplates/seahorse-fluxpaks-740883


Seahorse XF Imaging and Cell Counting Software 3

Agilent Seahorse XF Imaging and Cell Counting Software User Guide 29

XF Cell Culture Microplate Preparation and Bright Field Imaging

1 Open the Cell Imaging application on the controller and ensure connectivity; wait for 
the Ready status in the lower left of the screen.

2 Prepare assay medium by supplementing Seahorse XF Base Medium. 
Recommendations for each XF Assay Kit can be found in their respective user 
guides. 

3 Wash XF Cell Culture plate and change media to prepared assay medium. 
4 Bring washed cell culture microplate to the Cytation instrument and navigate to the 

Cell Imaging application. Scan the barcode with the hand wand to initiate imaging 
procedure.

Figure 14 Imaging and Cell Counting application main menu
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5 You will be prompted to name the cell plate. This name will be used for any set of 
images that is associated with that plate (both Bright Field and Fluorescent image 
sets). Then, click Save.

6 The next screen shows the options for imaging protocols. Prior to the XF Assay, 
select Start Brightfield Scan. This page will also display any image sets that have 
previously been collected with this cell plate in the Previous Scan for this Plate 
menu.

Figure 15 Prompt requesting cell plate name

Figure 16 Plate & Scan menu
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7 Place the cell culture microplate on the holder of the Cytation instrument. Keep the 
cell plate lid ON. Use the image in the dialog box to check if the orientation of the 
microplate is correct, then click Close Tray.

NOTE Agilent highly recommends a standard practice of wiping the bottom surface of the 
microplate with ethanol/isopropyl for better quality images.

Figure 17 Insert cell plate dialog box
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3 Seahorse XF Imaging and Cell Counting Software

8 The next screen shows the image acquisition screen. On the plate map, you may 
select specific wells to be imaged, as is shown, or click Scan All Wells to image the 
entire plate.

9 Before images are collected, there are a few initialization steps that may take up to 
2 minutes. (Temperature must reach 37 °C inside the Cytation and there are 
auto-exposure and white-balance steps). 

Figure 18 Well selection screen

Figure 19 System initialization
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10 An entire XF96 well plate may take up to 35 minutes to image. During this time, 
prepare the XF Assay Kit and load the sensor cartridge. While the cell plate is in the 
Cytation instrument, the plate is heated at 37 °C in a non-CO2 environment. Cell 
Imaging will keep a timer for cell plate outgassing, and the plate will stay in the 
Cytation until the user removes it for the XF Assay. Total outgassing time is 1 hour.
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XF Assay Preparation

1 Prepare XF Assay Kit Compounds as directed in the appropriate XF Assay Kit user 
guide. 

2 Add Hoechst stain to the final reagent in the injection scheme for your XF Assay. 
Alternatively, add an injection to the assay for the Hoechst dye. 
a We recommend optimizing the concentration of Hoechst dye needed for your 

cells. Our testing was completed with Hoechst 33342 from Thermo Scientific; 
Catalog Number PI62249. 

b Create a titration of Hoechst dye over a plate seeded with the same number of 
cells in each well; we recommend a starting point of 20 µM injection solution 
concentration. 

The dye is most active and best imaged within 20 to 45 minutes of injection. By 
default, you may need 3 to 5 measurement cycles after the final injection. This 
equates to 18 to 30 minutes on the XFe96 and XF Pro Analyzer, and 24 to 40 minutes 
on the XFe24 after the injection, but before the plate may be removed to be imaged. 

3 Load prepared reagents in XF Sensor Cartridge drug ports. Ensure reagents including 
Hoechst dye are included in the final injection of the series. Alternatively, designate 
an additional port after any reagents have been injected to add the Hoechst dye. Use 
the table below for injection port volume recommendations:

4 Begin XFe Assay calibration: using an existing template or create your own design, 
load the cartridge and begin calibration. It will take about 20 minutes before the 
cartridge is calibrated - this can be performed while the cell plate is in the Cytation 
instrument. 

5 Once outgassing and cartridge calibration have both completed, remove the cell 
culture plate from the Cytation instrument, click Load Cell Plate in Wave, and move 
the cell plate to the XFe instrument for reading. 

XFe96
Starting Well Volume (180 μL)

XFe24
Starting Well Volume (500 μL)

Port Injection Volume (μL) Injection Volume (μL)

A 20 56

B 22 62

C 25 69

D 27 75
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After XF Assay Completion

1 Upon completion of the XF Assay, remove the plate from the XFe or XF Pro 
Analyzer.

2 Carefully remove the sensor cartridge and replace the cell plate lid. The cells are 
ready for fluorescent imaging and cell counting. 

3 It is helpful to check the cartridge or the XF Assay data for any injection failures. If 
the reagent containing Hoechst dye failed to inject, the cell count will not be 
appropriate. 

4 Scan the plate barcode with the handheld barcode reader. If the plate has already been 
imaged, it will not require a new name. 

5 Select Fluorescence & Cell Count.
6 Place the cell plate on the Cytation tray holder.
7 Wipe the bottom of the plate with ethanol/isopropyl.
8 Click Close Tray.
9 In the image acquisition window, select the wells to be imaged, or select Scan All 

Wells to begin imaging. Fluorescence imaging takes about 15 to 20 minutes to scan 
the entire plate.

NOTE The following wells must be seeded and stained to ensure successful initialization of 
autofocus and autoexposure:

XF96: C5 and D8

XF24: B3 and C4

NOTE Images are not available for review while they are being collected. Once the Cytation 1 
has collected all images and counted each well, the images will be available for review. 
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10 Review fluorescent images and cell counts in the Imaging and Cell Imaging 
application. Notice that there is an option to View Counted Cells (highlighted in the 
figure below). This option shows a 'masked' image, highlighting the objects that were 
counted. 

11 If the images are satisfactory and the cell plate and sensor cartridge are no longer 
needed, they may be discarded appropriately. 

NOTE Note that the algorithm uses the brightness of the stained nuclei to determine whether it 
is an 'object' or not. Some common counting problems include variation in intensity and 
failed dye injections. 

Be sure to optimize the concentration and incubation time for Hoechst dye and check for 
injection failures. 

Figure 20 Reviewing fluorescent images
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XF Data Normalization

1 After image collection is complete, image review and data normalization can be 
performed in Wave. From the Wave application, open the appropriate assay file. 

2 To review images, use the Add button and choose Well Images. This adds the images 
to your available Views. 

Figure 21 Adding images to your available views
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3 On the Well Images tab, choose Bright Field or Fluorescent images from the Image 
Sets menu. Click on each well to review the images. You may also compare image 
sets and flag wells using the star in the upper right-hand corner of the images 
(highlighted in yellow). 

4 Heat Maps are also available in this view. The heat map uses cell count values to 
visually display cell counts. Click the Heat Map drop-down list box and choose to 
either view by group, or across the entire plate:

Figure 22 Flagging an image for comparison

Figure 23 Viewing heat maps
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5 To Normalize XF Data using the cell counts collected, navigate to the Normalize tab 
of the Functions options. Notice that there should be 
an symbol noting that Cell count data available. 

6 Click Import to fill in the table with cell counts. Note that wells defined as 
background will remain empty (there are no cells in these wells). 

7 Upon cell count import, the default scale factor is 1000 and the normalization unit is 
1000 cells. Ensure scaling is appropriate, then click Apply to view normalized XF 
Data.

Figure 24 Normalizing XF Data using the cell counts collected

NOTE Please note that importing images and cell counts using Wave Desktop or Wave Pro (on 
a PC) is not currently supported with the use of the Cytation 5. Images and cell counts 
must be imported to the assay result file using the XFe Analyzer's Controller or the 
XF Pro Analyzer’s Controller.
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Registering the Software 43

The Cell Imaging software allows a 30-day window for initial registration. If the 
controller cannot be networked, registration can be completed on a PC or laptop. An 
authorization code required for activating the XF Imaging and Cell Counting software 
license is delivered along with the rest of the normalization solution components. 
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Logging into SubscribeNet

Agilent SubscribeNet is an Electronic Software Delivery service provided by the Global 
Software Distribution Center for Agilent employees and Non-Agilent workers.

For customers of Agilent log in here:

https://agilent.subscribenet.com

For Agilent employees log in here:

http://softserv.cos.agilent.com/register.html
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Registering the Software

1 To connect the controller to a local network, refer to the Networking guide.
2 Open SubscribeNet and select CLICK HERE at the bottom of the screen 

Figure 25 Registering a new account
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3 Fill in the required fields and click Submit. 

Figure 26 Registration information
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After registration has been submitted, a new screen will appear with the license.

4 Select the Seahorse XF Cell Counting Software License. A screen will appear, 
prompting for an Authorization Code. This is found on the sticker received with the 
upgrade. 

5 Enter the code and click Submit.

Figure 27 Selecting the license

Figure 28 Entering the authorization code
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6 The next dialog prompts the generation of the license. Choose the check box next to 
the desired license and then click Generate.

7 The next screen requires the MAC address. Find the MAC address on the controller.
a Open the Cell Imaging application.
b Navigate to the Help menu to find and copy the MAC address.

8 Paste the MAC address into the Host ID MAC Address bar.

9 Choose the check box next to the desired license and then click Generate.

Figure 29 Generating the license

Figure 30 Finding the MAC address

Figure 31 Adding the MAC address
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10 Click Download License File. This file will be saved in the "Download" folder. The 
title of the file will be the MAC address. 

11 Copy this license file to the folder path shown below:

12 Rename the file to "vortex.lic"
13 Return to the Help menu in the Cell Imaging application to verify that the Agilent 

License is valid. The software may need to be closed and reopened to show the status. 
14 If a controller needs to be replaced, the license may be returned for another and setup 

on the new controller. In SubscribeNet, click Return and follow the instructions.

Figure 32 License path

Figure 33 License returns
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